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GENERAL

The Carrier wireless transceivers enable connection to the
Carrier Comfort Network (CCN) in areas where standard wir-
ing cannot be used. The wirdless transceiver can be plugged
into any standard serid port (RS-232 or RS-485) on a wide
variety of devicesto provide CCN communications.

Wireless bus extension is only recommended if there are
no CCN secondary busses. Wireless extension of secondary
bussesis not recommended.

The wireless transceiver operates in the license-free portion
of the FCC designated | SM (industrial, scientific, and medical)
frequency band at 2.4 GHz. It isidedl for transmissions over
long distances: up to 1500 ft indoors and line-of-sight to the
horizon outdoors. Data is transmitted reliably and securely
with wireless communications which enable service-interface
mobility.

The wirdless transceivers operate in point-to-point pairs and
broadcast networks.

Two wireless transceiver kits are available from Carrier.
The 33CNWIRMOD kit contains the following: 2 wireless
transceivers, 2 power supplies, 2 RS-232 to RS-485 converters,
2 RS-232 cables, Carrier Wireless Transceiver Configuration
Manager, 2 antennas, and aloopback connector.

The 33CNSNGMOD kit contains the following: wireless
transceiver, power supply, RS232 to RS485 converter,
RS-232 cable, and an antenna.

In order to communicate outdoors between structures, an
additiona outdoor antenna (part number 33CNOAANT1) is
required for each wirelesstransceiver.

Frequency Hopping — The Carrier wireless transceiv-
ers use Frequency Hopping Spread Spectrum (FHSS) technol -
ogy to ensure secure, reliable long-range data transmissions.
Frequency Hopping Spread Spectrum technology was devel-
oped by the U.S. military to prevent interference or intercep-
tion of radio transmissions on the battlefield.

Frequency hopping devices concentrate their full power into
avery narrow signa and randomly hop from one frequency to
another within that spectrum up to 200 times per second. If they
encounter interference on a particular frequency, the devicesre-
tain the affected data, randomly hop to another point on the
spectrum, and continue transmission. There are aways spaces
without interference somewhere in the allotted radio spectrum.
A frequency hopping device will find those spaces and com-
plete atransmission where other wirelesstechnologiesfail.

Carrier wireless transceivers use demand-based freguency
hopping where RF (Radio Frequency) isonly transmitted when
there is data available to transmit. The initiating transceiver is
termed the master and the receiving transceiver is caled the
dave. Any device (host or remote transceiver) can be a master
or adave depending on which device initiates the data transfer.

Transmit Power Control — Wireless devices in close
proximity often experience desensing or overloading. Carrier
Wireless Transceivers minimize this problem by providing ad-
justmentsin the Power Level Feedback Control Loop based on
the time-averaged Received Signa Strength Indicator (RSSI)
vaues and the Actua Power Level Setting as shared between
both devices during a communication session.

Security — Frequency hopping is inherently more secure
than other RF technologies. In addition, each transceiver has a
Carrier ID setin the firmware shipped straight from the factory.
Asthe user configures each transceiver, additional network 1D
numbers may be provided and varying hop tables for indepen-
dent networks may be assigned. The combination of firmware,
software IDs, and frequency hopping technology ensures safe
and secure data transmissons. Carrier wireless transceivers
also support your data encryption software.

Manufacturer reserves the right to discontinue, or change at any time, specifications or designs without notice and without incurring obligations.
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PREINSTALLATION

Every ingaler should perform site evauation prior to
ingtalling the transceivers. In order to perform this evaluation
the following minimum equipment must be purchased from
Carrier. The two modem garter kit (33CNWIRMOD) is re-
quired to begin performing a ste evauation. The following
components are in the two modem kit:

2 — dlandaone transceivers

2 — high gain omni-directional antenna

2 — transceiver power supplies

2— RS-232 to RS-485 converters

2— 9-pin RS-232 cables

1— copy of transceiver configuration software
1 — loopback connector

If the set up requires outdoor antennas they can be pur-
chased from Carrier as part number 33CNOAANT 1.

High gain directional antennas may be required to establish
reliable communications. Directional antennas can be pur-
chased directly from the antenna vendors described in the an-
tenna selection and location section of this manual.

Site Evaluation Testing — Loopback Test — In
order to perform aloopback test the transceivers must be con-
figure Broadcast Remote-to-All. Seethe Remote-to-All config-
uration section of this manual.

To perform a loopback test it is necessary to connect each
modem (one host and one remote) to its power supply. Then
connect a PC with the Configuration Manager software to a
modem using the 9-pin RS-232 cable provided. Lastly, connect
the second modem directly to the loopback connector. See
Fig. 1.

Perform the loopback test by executing the following steps:

1. Position the modems directly on top of each other and re-
move both modem antennas if connected. Use ahost and
remote pair for thistest.

2. Run the Configuration Manager on the computer and log
into the software using the username “oem” and pass-
word “oem

3. Sdlect the Loopback Test program tab within the Config-
uration Manager software.

4. In the Test String diadlog box enter a text string such as
TESTING.

5. Using the pointer place a check in the Test check box.
6. Using the pointer sdect the Instantaneous RSS! option.

7. Pressthe Start button on the screen to begin sending the
Test String.

8. The TX pane should start displaying the Test String at
regular intervals. If the string is being received and sent
back by the remote transceiver the RX pane should dis-
play the sametext screen. If the Test String is successfully
transmitted through the loopback connector with the
transceivers on top of each other proceed to Step 10.

9. If the RX pane displays “Timeout?’ each time the Test
String is sent then perform the following tests:

a. Verify that both transceivers are properly config-
ured for Broadcast Remote-to-All operation.

b. Verify that both antennas are removed from the
transceivers (NOTE: if antennas are connected and
located too close together the two antenna fields
will cancel each other out).

c. Verify that cycling power to the modems shows the
3-flash blink as described in the Getting Status sec-
tion of this manual.

Configuration Manager e

Software P %
rereIess
;; RS232 |Modem‘
. Cable Link
Loopback
Connector

Fig. 1 — Loopback Configuration

10. After successfully establishing communications between
the two transceivers localy, locate the transceivers in
their desired locations and repeat Steps 2 through 8.

1. If thetext string is being received and sent back by there-
mote transceiver the RX pane should display the same
text string. If the text string is successfully sent and
received the transceiver and antenna locations are
acceptable. The green sync light should remain lit once
thefirst datais sent.

12. If the RX pane displays Timeout? each time the Test
String, is sent them perform the following tests or the
sync light will not remain on:

a. Verify that both antennas are properly installed on
the transceivers.

b. Reposition the transceivers such that the green sig-
nal strength bar is as long as possible. Normally
signal strengths above .5 are required for reliable
communications (see Antenna Selection and Loca
tion section).

c. Attempt to utilize directional antennas in order
to obtain reliable communications (see Antenna
Selection and Location section).

INSTALLATION

Hardware Installation — Prior to ingaling the trans-
ceiver(s), count and check all of the delivered equipment. A
power supply and an antenna is required for each transceiver.
Thetransceiver will be attached to either RS-232, RS-485 con-
verter to a PC or laptop. Prior to installation on the desired de-
vice, dl transceivers must first be connected to and configured
withaPC.

Carrier recommends mounting wireless transceivers inside
a building structure. Refer to Table 1 for temperature and
humidity criteria when mounting transceivers. If an antenna
is mounted outdoors or the CCN network extends outside of
a building, use of an RS-485 surge suppressor is recommend-
ed. Refer to CCN ingdlation and Start-up Instructions for
lightning/surge protection recommendations.

To ingtall the transceiver, perform the following procedure
and refer to Table 1 for hardware specifications:
1. Insert the power supply male connector into the corre-
sponding female connector dot on transceiver chassis.

2. Insert power supply plug into power (i.e., power outlet).
Verify LEDs 1 and 2 on front pand blink three times.
LED 1 should remain lit.

3. Attach the antennato the transceiver.
NOTE: The antenna connection is areverse thread SMA
connection. It must be turned countercl ockwise to attach.
4. Attach the male connector on the RS-232 cable to the
matching seria port on the rear panel of the transceiver.

5. Connect the other end of the RS-232 cable to the match-
ing seria port on the device.



Table 1 — Hardware Specifications

Frequency 2.400-2.4835 GHz license-free ISM band in U.S. (varies in other countries where transceivers have been certified)
Radio Type Frequency Hopping Spread Spectrum

Number of Channels 417 independent, non-interfering frequencies

Data Rate 600 bps to 9.6 kbps full duplex

Transmit Power Output 10mW to 500mW nominal, self-adjusting (lower maximum power output where required)

Indoor Range Up to 1,500 feet (457 m) in normal construction

Outdoor Range

Up to 2 miles (3.2 km) with omni-directional antenna.
Up to 12 miles (19.3 km) with optional directional antenna (line of sight to the horizon)

Protocol CSMA (Carrier Sense Multiple Access)

Flow Control Supports Hardware, Software or None

Error Detection & CRC 16 error detection; forward error correction can correct errors in 1 out of every 4 bits transmitted
Correction

Certification Other International certifications pending

FCC Part 15 Certified, Industry Canada, Japan, Europe, Brazil.

Electrical Interface RS-232C Voltage Levels
Physical Interface Standard RS-232C DB-9 (female) connector

Shipped with a 115VAC power adapter providing: Voltage: > 6.5 V and < 9.0 V Ripple: Less than 250mV (RMS) from DC to
Input Power 1MHz

Input Current Draw Idle: 200mA Transmit: 550mA instantaneous current Transmit/Receive (time averaged over 100msec): 360mA

Environmental Temperature | -4 F to +140 F, —20 C to +60 C
Range

Humidity 0% to 95% (non-condensing)
Physical Dimensions 1.2 inches height (30mm) x 3.8 inches width (97mm) x 5.2 inches length (132mm)
Weight 6 ounces (170 grams)
Serial Communications — In order to configure any b. Locations directly adjacent to walls or other
transceiver, a 9-pin RS-232 cable must be used. This is neces- structures should be avoided for omni-directional
sary because Pin 4 is used to tranamit the configuration data antennas.
into EEPROM and other pins are used during the configuration c. Barriers between antennas should always be con-
prOC%$WdI (%Td)leZ)A 9-pln RS-232 CableISIndudaZi sidered (we barrier information on pwe 16 for
with all stand-alone transceivers. degree of penetration).
The 9-wire cable must be used in the following cases: d. Antennas should be moved within the desired
« when using the Configuration Manager to initialize/ space to determine if a better location within the
setup atransceiver desired area can be found.
» when a Carrier CCN Interface is connected via the 2. Polarization
. vﬁlhse%%eﬁ) grltj rading the transceiver software a  Antennas must be oriented in the same plane. For
P9 9 example, omni-directional stick antennas must
Software Installation both be vertical in the same plane in order for reli-
The software has the following requirements: " aDt_)Ies':gnaall rec:ept|on. < be oriented in th
. ; : . Directional antennas must be oriented in the same
xvsggj()jows® 95/98 or above (depending on software plane utilizing the vertical pole identification on
Pentium processor 233 MHz or higher the antenna, o
1 available RS-232 serial port 3. Omni-directiond vs. Directional

Minimum 32 MB DRAM

Maximum 20 MB hard disk space for Configuration

Manager

CONFIGURATION MANAGER — The Configuration Man-

ager program is used to configure all transceivers.

To ingtall the Configuration Manager software, perform the
following procedure:

1. Make suredl Windows applications are closed.

2. Insat the Ingalation CD-ROM into the appropriate
drive. Select folder “CONFIG_111300" then sdect
“Disk 1".

3. Open the contents of the drive usng Windows Explorer
or My Compuiter.

NOTE: Take note of al warnings and notes that refer
to computer/software requirements when running this
program.

4. Double-click on“Setup.exe.”

5. Follow the on-screen ingtructions.

Antenna Selection and Location — Severa factors
effect signal strength:

1. Location
a. Line of sight between antennasis always preferred.

a

b.

Omni-directional antennas provide essentialy
equal signal strength around the antenna.

Omni-directional antennas can receive a signa
coming from virtually any direction in relation to
the antenna as long as polarization is not a factor.

Directiona antennas provide greater signa
strength in the direction that the antenna is
oriented.

Directional antennas are labeled with a vertical
pole for proper orientation with both omni-
directional and directional antennas.

Directional antennas should be pointed in the
direction of the receiving antenna.

Directional antennas will not receive any signals
coming from behind the antenna.

Directiona antennas should be rotated to deter-
mineif bouncing the wireless signal can be utilized
in order to achieve wireless communications.

For best results it is recommended that a direc-
tional antenna be used in conjunction with an
omni-directional antenna. With this setup signal
strength is improved while antenna lineup is fairly
straightforward.



Table 2 — Stand-Alone Transceiver Pin Out

PIN NAME 1/0 FUNCTION
1 DCD — Data Carrier Detect Qutput Session Status (True)
2 TxD — Transmit Data Output Data from transceiver to the attached device
3 RxD — Receive Data Input Data into transceiver from the attached device
4 DTR — Data Terminal Ready Input Data/Command Mode
5 Gnd — Signal Ground
6 DSR — Data Set Ready Output Always Asserted (High)
7 RTS — Request to Send Input HW Flow Control (internally pulled up)
8 CTS — Clear to Send Output HW Flow Control (default: asserted/High)
9 Rl — Ring Indicate Qutput Status Change (default: de-asserted/Low)

Antenna Installation — Antennas must be connected
to each transceiver for proper operation. Without an antenna,
two unitswill not communicate. The higher the gain of the an-
tenna, the longer the range of the transceiver signd. All Carrier
transceivers ship with a 5 db omni-directiona 9-in. antenna.
An outdoor antennaiis also available from Carrier.

Carrier transceivers are designed to be used only with cer-
tain antenna products. Other higher gain directional antennas
may be purchased through an approved Carrier supplier. Con-
tact Carrier for additional information.

Installation onto a CCN Bus — Use the RS-232 to
RS-485 converter to ingall transceivers directly onto an
RS-485 network. An RS-232 to RS-485 converter and power
supply is supplied with each transceiver.

1. Separatethe RS-485 converter’s housing with aflat blade
screw driver.

2. Ingtal jumpersinal 5terminals.

3. Wirethe CCN (+) to screw termina Pin 1, and CCN (-) to
screw terminal Pin 2. See Fig. 2.

4. Cut the power plug off of the power cube 6 in. from the
end.

5. Wire the ground wire of the power supply wire to screw
terminal Pin 5 and the positive (wire with white line) to
screw terminal Pin 6. See Fig 2.

If atransceiver is used to connect directly to a computer, an
RS-232 to RS-485 converter is not required. Only the 9-pin
cable (supplied) is used.

CCN (-) BLACK
V(+)

V (GND)

o
OoF—
(o]
(o]
(o

©o~nw— | OfF—

b

—
OODAN

—
LEGEND

CCN — Carrier Comfort Network
GND — Ground (-)

NOTES:
1. Install end of line termination jumpers between 1 and 2, 3 and
4 if unit is used with the RS-485 network.
2. Install jumpers between 5 and 6, 7 and 8, 9 and 10 to use the
converter in a CCN 2 wire set up.

Fig. 2 — Converter Detail

NETWORK TOPOLOGY

The Carrier transceivers support the Broadcast Network
topology. Each transceiver can be configured viaits Configura:
tion Manager to work thistopology. The transceiver’s Configu-
ration Manager controls how the transceiver transmits and re-
ceives data as connected to the device. (See Fig. 3-5.)

A CAUTION

Wireless communication signals can be adversely affected
by physica and/or electrica interference. Carrier wireless
transceivers should NOT beingtalled in applications where
temporary loss of communications cannot be tolerated by
the control system. Suitable applications include equipment
monitoring, alarm monitoring, control overrides and tem-
porary service connections.

Networks — Wirdless data connectivity applications
require a wide range of networking options. The network
topologies consist of more than two transceivers and may have
a PC to host a network of devices. The PC or network devices
are each physically attached to atransceiver.

WIRELESS SERVICE TOOL — The wireless Service Tool
setup alows a CCN service technician to ingtal, commission,
and troubleshoot from any location in the building. All CCN
elements on the primary bus are accessible. The wireless con-
nection alows the technician to utilize a laptop computer to
perform all Service Tool functions from anywhere within the
range of wireless communication. If the transceiver is located
on arooftop, it is possible to gain wireless access to the build-
ing from several miles away.

NOTE: Wirdless buss extensons on CCN systems with sec-
ondary buses are recommended for temporary use only. Per-
manent useisNOT recommended.

WIRELESS BUS EXTENSION — The wireless bus exten-
son setup alows a bus to be extended to a remote location
through the use of the wireless transceivers. This set up can be
used to connect two portions of a CCN buswhen physical wir-
ing cannot be used or is not cost effective. This set up may also
be used to connect controllers in two different buildings by
placing the transceiver on the roofs of the buildings. This set up
is not recommended for CCN systems that contain secondary
buses.
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Wireless links can only be used to extend a CCN primary
bus (bus D). Do not use bridges when using a wireless link.
Utilizing this primary bus wireless connection to access CCN
devices through a bridge will cause communication messages
to be generated on the primary bus.

The wireless bus extension setup alows primary bus to be
extended to a remote | ocation through the use of wireless tech-
nology. This set up can be used to connect two portions of a
CCN primary buswhen utilizing physical wire may be a costly
or difficult task. This set up may be used to connected control-
lerswithin a building or to another building by placing the mo-
dems on the roof s of the structures.

A wireless bus extension on a CCN primary busisonly rec-
ommended if there are no CCN secondary busses. If CCN
bridges are ingtaled a wireless extension of the primary busis
not recommended.

BROADCAST NETWORK — In aBroadcast Network, data
is sent out by one transcelver (sending transceiver) and re-
ceived by an unlimited number of remote devices smulta-
neoudy. These devices must be intelligent enough to recognize
relevant messages and recover lost or corrupted data. Broad-
cast Networks operate solely as configured by the Configura-
tion Manager.

Transmissions sent by the sending transceiver can be re-
ceived by every remote unit in its associated network. Trans
missions by remote units can be received by every other unitin
the network that is within range. Broadcast mode is epecialy
useful to applications where you must transfer the same infor-
mation to al units at once. (See Fig. 3.)

Broadcast mode is intended primarily to be a RS-485 net-
work wire replacement. It is especially useful in adding new
equipment to systems where thereis a RS-485 connection. The
RS-232 to RS-485 converter is needed to configure transceiv-
ersfor RS-485 devices.

An example of the broadcast set up would be awireless bus
extension to multiple buildings. The wireless bus extension set
up dlows any primary busto be extended to aremote location.

TYPICAL SET UP (QUICK START)

The following set up will guide the user through the steps of
the set up, configuration, and test for Network wireless opera
tion. These procedures assume that the | ocations have adequate
power, peripherals, and host devices.

Quick Configuration — Thisis the fastest and easiest
way to configure a unit. Activation of Quick Configuration
loads settings directly into EEPROM. These settings will re-
main in effect until aunit is reconfigured.

1. Click Quick Configuration on the Generd tab, click it on

the toolbar, or sdect it from the Commands menu. The

Quick Configuration wizard appears with the Operating

Mode window displayed.

Select the desired Operating Mode.

3. Sdect Broadcast (Host) for a network configuration of 2
or more transceivers on a Broadcast network. When con-
figuring dave modems, configure a remote to talk to al
remotes on the network. If host is configured first, the
wizard will provide options for configuring remotes. See
Broadcast Network for a more detailed explanation of
Broadcast modes.

N

IMPORTANT: All other selections are NOT appli-
cableto Carrier CCN set ups.

4. Click OK.
The Unit Settings screen appears.

Broadcast Remote-to-All — Materials/equipment
needed:

e 1HostPC

e 2 o0r moretransceivers

e 2 o0r moreantennas

e 2 0r more power sources (outlet and/or surge strips) and
2 or more power suppliesfor transceivers

e Configuration Manager software

e (2 or more) RS232 cables

Use the following procedure to install software and config-
ure transceiver.

1. Ingtdl software.
a. Power up Host PC.

b. Insert the Configuration Manager software into the
appropriate drive.

c. View the contents of the drive (using Windows
Explorer, My Computer etc.).

d. Double-click Setup.exe.

e. Follow the on screen instructions to complete the
installation.

2. Connect the transceiver.
a. Attach the power supply to transceiver 1.
b. Plug the power supply into power source.

c. Veify that LED 1 on the front panel of the trans-
ceiver blinks 3 times and remains lit.

d. Attach an antennato transceiver no. 1.

e. Insert the RS-232 cable connector into the serial
connector in the back of the transceiver.

f. Attach the other end of this cable into the serial
port on the back of the Host PC.

3. Configuretransceiver no. 1.

a. Select Configuration Manager from the Start menu
in Windows. Log in using username: oem and
password: oem.

The Main window appears.
Click Quick Configuration.
Click Host to Broadcast.
Click OK.

Enter the information as shown in the dialog box
below. See Fig. 6.

g. Click Submit.
4. Generateareport (if desired).
a. Click Report Generation.
b. Click Close.
c. Click Yes.
5. Connect and configure transceiver.
a. Click Remote To All.
b. Click OK to configure another unit.
C.

Disconnect serial connector from transceiver no. 1.
(You can leave it connected to the computer.)

d. Attach power supply to transceiver no. 2.
e. Plug power supply into power source.

f. Verify that LED 1 on the front panel of the trans-
ceiver blinks three times and remains lit.

Attach an antenna to transceiver no. 2.

Insert the RS-232 connector into the serial connec-
tor in the back of the transceiver.

i. Insert the RS-232 connector into the serial connec-
tor in the back of the transceiver. See Fig. 7.

j. Click Submit.

000

J Q@



‘Broadcast [Host])' Unit Settings E4 |
Metwork |D IE

Alias Netwark [NE T'WORK 4

Source Unit 1D Iﬂ

Alias Source Name [Device Host

Destination 1D I'I
Hop Table |u v[ © X & 8%

— Seiial Settings
RateParity.. | 9B00.8N.1
Flow Contral | Hardware Change |
GPIO Mode |  Disabled

I Submit I

Cancel |

Fig. 6 — Host to Broadcast Set Up
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Fig. 7 — Transceiver 2 Configuration

k. Repeat as necessary for more transceivers.
[. Check Report Generation.
m. Click Close.
n. Click Cancel.
0. Select Exit from the file menu.
. View the report.
a. Open Windows Explorer.

b. Once in Windows Explorer, Open the following
filee C:\Program Files\Configuration Manager\
RReport.txt.

7. Test Operation.

Connect transceiver no. 1 to the host PC. Connect trans-
celver no. 2 to the loopback connector. Ensure all
transceivers have power and have antennas properly con-
nected. Run the loopback test in the Unit Testing section
of thismanual. Repeat with the host and each remote unit.

ADVANCED CONFIGURATION

The Configuration Manager is used to configure al trans-
ceivers being used in the network. The procedures in this sec-
tion describe how to configure the transceiver to meet your
specific needs. This section should be used in conjunction with
the Typical Set Ups (Quick Start) section. SeeFig. 8.

To open your Configuration Management application:

1. From the Start menu in Windows, select Programs and
then Configuration Manager.
A splash screen appears with a Login diaog on top re-
questing username and password.

2. Enter the username: “oem”

3. Enter the password: “oem”

NOTE: “oem” islower case.

4. Click OK. The Main Window appears. A Tip of The Day
window also appears. A new tip of the day will appear
each time you open the configuration program. You can
turn this off by unchecking the box. Click OK to dismiss
the window.

Getting Status — Status lights on the Status bar indicate
the status of the control lines on the RS-232 link between the PC
and the transceiver being configured. See Fig. 9 and Table 3.

In addition to the status lightsin the Configuration Manager,
the LED’s on the stand-alone transceiver also display status.
See Fig. 10.

Exiting the Program — In order to exit the Configura-
tion Manager, refer to the following.

Select Exit from the File menu.
NOTE: It is important to note that any changes in any tab not
stored in EEPROM will be lost.

Table 3 — Status Definitions

ABBREVIATION NAME DEFINITION
A signal is coming
RI Ring Indicator into the host unit

from the transceiver
at the remote unit.

A connection has
been established
with another unit.
DCD Data Carrier Detect | This lets the PC
know that communi-
cation between two
units can take place.

Indicates that the
unit is in Command
Mode. This mode is
utilized by the net-
work software.

This is a hardware
RTS Ready To Send flow control indicator

Data Terminal
DTR Ready

A hardware control

CTS Clear To Send indicator
DSR Data Set Ready E{éeeserved for future
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Fig. 8 — Configuration Manager

Modifying Settings — You can run the Quick Configu-
ration wizard to modify settings or you can change entries
manualy in the fields in the modification tabs provided. When
manually changing entries, you must click apply and/or store
for the changesto take effect. (See Fig. 11.)

To manually change dataiin fields:
1. Click the desired tab.
2. Click inand highlight the datato be changed.
3. Changethedata
4. Click Apply and Store to save changes.

APPLYING AND STORING CHANGES — The following
features can be selected from the Commands menu or you can
click the appropriate button on the toolbar. These features write
the information entered into temporary or permanent storage.
SeeFig. 12.

NOTE: Settings must be applied before they can be Sored.

APPLY — This applies (transfers) changes from the dl tabs
into the attached transceiver's RAM (temporary memory). This
is useful when changing and testing settings you are not sure
you redly want.

NOTE: When you exit the configuration program these
changes will not remain in effect. You must click Store for
them to become permanent.

STORE APPLIED SETTINGS — Stores al Applied chang-
s into the transceiver's EEPROM. These settings will remain
in effect upon exiting the program. Stored changes are over-
written when new stored entries are made or when you load the
default factory settings. You must Apply settings prior to stor-
ing them.

RESET UNIT — Performs a soft reset of the attached unit re-
turning the settings stored in EEPROM. Any configuration set-
tings Applied but not Stored to EEPROM will be lost.

LOAD DEFAULT SETTINGS — Reloads Factory Default
settingsinto unit. All changes made previoudy will be lost.
REFRESH — This queries atransceiver about its current set-
tings. These settings will be displayed on the screen. It lets you
go back to the last Stored settings before Apply was selected.
Settings will not be refreshed if Store has been selected.

B BocQor QesiQ s O osk
Fig. 9 — Status Bar
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Fig. 10 — Status Lights

Quick
Apply Store Configure Clear RX Help

| ¥ |«

Refresh Reset Reload  Change Clear TX
Password

Fig. 11 — Toolbar

Host PC Transceiver

Apply
—'.
RAM

Store EEPROM

Fig. 12 — Setting Storage Process



Generating Reports — Reports can be generated dur-
ing the Quick Configure (if the box was checked) or can be
generated at any time using menu commands. Two types of re-
ports can be generated. Information in each report can be
cleared separately. Both reports generate text (.txt) files. The
default location for reports is C:\Program Files\Configur a-
tion Program. The RReport.txt file produces aformatted text
file which can be viewed using any text reader or word pro-
cessing program, for example, Microsoft Word®. The
DReport.txt produces a comma delimited ASCII report which
can be viewed with any spreadsheet program, for example
Microsoft Excel®. It can also be imported into a database pro-
gram like Microsoft Access®.

1. Addtoan existing report.

a. Select Add To Report from the File menu. The
configuration data profile for the attached trans-
ceiver is added to the report in the location speci-
fied under the Report Settings command.

2. To change report settings.

a. Select Report Settings from the File menu. A dia
log appears showing the settings and location for
storage of configuration data profiles.

Select the type of report desired or both. See
Fig. 13.

Both files generated are ASCII files readable by
any text reader. A readable report is formatted in
ASCII with spaces and tabs to make it readable
when opened in programs such as Notepad.
Comma delimited formatting is useful when you
want to import the text into spreadsheet or database
programs. Clear the contents of a report by click-
ing Clear Report. If you wish reports to be gener-
ated when you run Quick Configuration, the
Report generation box must be checked.

Click OK.
3. To View reportsin ASCII format.
a. Select Report Settings from the File menu.

b. Locate the path to the desired report. You can close
this window and the Configuration Manager if
desired.

c. Using atext reader such as Notepad or aword pro-
cessor, open thefile.

Reports Filez: Settings

4. Example: Toimport reportsinto Microsoft Excel:
Select Report Settings from the File menu.
Check Tab Delimited.

Open Microsoft Excel.

Select Import From the File menu. The Text
Import wizard appears.

Import the DReport.txt file.
Click Comma and Tab in the Delimiters box.

Click Next and fill out the rest of the wizard
as desired. Each comma in the delimited file
will be transformed into a column in the Excel
Spreadsheet.

Serial Settings

NOTE: This unit is factory set for Carrier CCN use. Do not
change the unit Serial Settings.

Power Management — Power management features
are preset for the Carrier CCN application and do not need to
be atered. See Fig. 14 to view power modes.

Passwords and Access

LEVELS OF ACCESS — There are two levels of access
OEM and USER. Each level has access to different sets of
fieldsin the Configuration Manager. A User hasthe lowest lev-
e of access and is only able to change parameters in some of
the fields available to OEMs. OEMSs have access to all func-
tions. See Table 4.

All transceivers are shipped with OEM access. Itisup to the
administrator to assign user privileges from that point on.

PASSWORDS — Change the password as frequently as you
desire. A password consists of any combination of numbers or
letters up to 29 characters. Contact Carrier if a new password
file is needed. All units are shipped with “oem” as the pass-
word. It is recommended for security reasons to change your
password from the factory setting.

Depending on access level, you have User or OEM privi-
leges. The diad ogs that appear and the options available vary by
privilege.

NOTE: All units are delivered with OEM privileges.

o0 oo
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file

Report File Location :

— Comma Delimited ASCI Repart Sethings
W Output Comma Delimited ASCH Report

Clear Repart |

W Beport generation on Quick Configuraton
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Fig. 13 — Report Settings
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Fig. 14 — Power Management Window

USER FUNCTIONS — To change the password as a user:
1. Sdect Change Password from the File menu. Change

password dialog appears. See Fig. 15.
2. Enter the desired criteria.

Enter user name and new password. Retype the new pass-
word in Confirm Password.

3. Click OK.

OEM FUNCTIONS — All units are delivered with default
OEM privileges. The system administrator must set units to
User access.

To access OEM privileges:

Select Change Password from the File menu. See Fig. 16.
Change password dialog appears.

Sedlect the desired User name from the list.

Change user permissions as desired.

A wWDNPE

Table 4 — Privilege Options

PRIVILEGE
User privileges

OPTIONS

Assign privileges as OEM or User.
They can also be assigned Admin-
istrator privilege which provides the
ability to change user privileges. If
you are assigned as a User, you
can not add other users or change
the passwords of other users. Click
update for these changes to take
effect.

Add a new user by typing in their
name and password. You must
retype the password to confirm it.

Change the password of an exist-
ing user by typing in their name
and password. You must retype the
password to confirm it.

Removes the currently selected
user.

New

Change password

Remove users

Using Hop Tables — A Hop Table is a liging of fre-
guencies in agiven spectrum that are used for communication.
Datais sent to each frequency in the table in a hopping pattern.
Hop Tables provide improved security and the ability to avoid
localized noise sources. There are 101 possible Hop Tables in
your transceiver (this number may vary for international trans-
ceiver models). These are subdivided into five completely in-
dependent, non-overlapping Hop Table sets, each with no more
than three consecutive frequencies. Each individua network
can only utilize one Hop Table.
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Fig. 15 — Change Password Window

ENTERING HOP TABLE NUMBERS — Hop Table num-
bers can only be entered or changed by using the Quick Con-
figuration wizard.

Enter the desired identification numbers. See Assigning IDs
section for acceptable parameters. Select a Hop Table (0 to
100). The Hop Table selected must be the same for al trans-
ceivers in a Point-To-Point or a Network. This number speci-
fies a table of predefined frequencies, which the transceiver
will usefor transmitting and receiving. If multiple separate net-
works exigt in the same area, each network should have a
unique Hop Table number to avoid RF collisons. Depending
on which network is selected in the previous screen, certain ID
fields may be grayed and inaccessible.

If multiple isolated wireless networks are ingtaled in the
same areg, it is recommended that hop tables 1-5 be used
sequentually.

VALIDATING THE HOP TABLE — This command veri-
fiesthe integrity of the Hop Table stored within the transceiver.
The Hop Table in the transceiver is compared to the Hop Table
with the same number in the Configuration Manager database.
The Advanced Settings tab provides the selected Hop Table
number and whether the Hop Table has passed validation and
the first and last indices used for the Hop Table. Index values
are st to meet the requirements of the country in which the
transceiver is deployed for a minimum number of hop frequen-
cies. These values can not be changed to avoid violating coun-
try regulations. To vaidate the Hop Table, from the Commands
menu, select Validate Hop Table.

SPECIFYING HOPPING PARAMETERS — You can cus-
tomize Hop Table parameters by setting some features avail-
able from the Advanced Settings tab.

Max No Data — (Adjustment of these settings is not
recommended.)

Max No Data is the number of hop cycles that must pass
during which no data was received and no data was available
for transmission before a sesson can be declared down. It is
used as the trigger to end a session. After a certain number of
Frames No Data between both units, the master will terminate
the current session/link.

Max BadHop — (Adjusment of these settings is not
recommended.)

Max Bad Hop is the number of data frames with errorsre-
ceived before a link is conddered bad. This is the trigger to
stop the current link and wait for a random standoff period
(approx. 0.5 to 3 seconds). Thisis due to the assumption that
after 4 consecutive bad hops (system default but can be
changed), the link has been lost — either due to interference or
lost synchronization. By waiting asmal amount of time before
attempting to reestablish the link, the obstruction (i.e., noise
source) may have moved somewhere ese.



Session Holdoff — (Adjustment of these settings is not
recommended.)

This will only be enabled for a host transceiver and is re-
quired to manage the communication from multiple remotes. It
prevents a host unit from starting a new session until it com-
pletesits current session. It keeps other devices from establish-
ing a session with the host until the host has completed its cur-
rent sesson with a particular device.

Assigning IDs — Using a combination of firmware and
software assigned | Ds, the security of thedatais ensured. Some
IDs can be modified and others cannot depending on your
privileges. The IDsareall accessed either viaQuick Configura
tion or the General Tab. See Fig. 16 and Table 5.

Table 5 — ID Types

ID TYPE EXPLANATION

Vendor ID Assigned at the factory and burned into the
firmware. This number is not modifiable.
This ensures that no other Carrier cus-
tomer can intercept data assigned to the
ID. There are 64,000 unique Vendor IDs.

A number that identifies the network and
makes it uniqgue from other networks in the
area. All units in a network must have the
same Network ID. The Network ID allows
the user to have multiple networks within
the same transceiver space. There are up
to 64,000 unique numbers. Units with dif-
ferent IDs cannot communicate with each
other.

For broadcast network communication, the
source ID = 0 for the host and the source
IDs for the remotes are 1.

Destination Unit ID | The numeric ID of the unit that the trans-
ceiver being configured will communicate
with. For a Broadcast network, the host will
have a destination ID =1. The remotes will
each have a destination ID = 0 (the host ID
number)

Alias Source Name | A descriptive name for the unit.
Alias Network Name | A descriptive name for the network.

Network ID

Source Unit ID

Signal Analysis — There are anumber of featureswhich
can help you analyze the strength and consistency of your data
signa. They are available via the Advanced Settings tab. See
Table 6.

Table 6 — Advanced Settings

FEATURE
TX Power

EXPLANATION

The transmit power of the unit rela-
tive to the possible power levels.

The upper RSSI (Received Signal
Strength Indicator) threshold which
when surpassed causes the unit to
reduce its transmit power.

The lower RSSI threshold which
when surpassed causes the unit to
increase its transmit power.

The operational temperature of the
unit as reported by the thermistor
in fractional volts.

The RSSI averaged over the last
16 transmissions. Used in analyz-
ing the strength and quality of the
transmit signal.

The value of RSSI for the last
transmission. Used in analyzing
the strength and quality of the
transmit signal.

Factory Diagnostic.

Power Ctrl Upper Value

Power Ctrl Lower Value

Temperature

Local time-averaged RSSI

Local instantaneous RSSI

D/A / A/D Loopback

Model |

Sernal Number |UDE{IEID5453

Date {10/25/99
Date [01701/38

Firmuare Rev. [1.14

Manufacturing Rey. |EI.IJEI

Wendor D Il]
|
2

Alias Yendor Name

Metwork 1D
Alias Metwork Name |Thomas

Source Unit D I'l

Alizs Source Name JREMOTE 2

Destination Uit 1D ID

Quick Configuration |

Fig. 16 — Quick Configuration Window

Unit Testing — You can test the operation of transceivers
in avariety of ways using the Configuration Manager. Thein-
gtructions in this section assume that the Configuration Manag-
er iscorrectly installed and the transceiver is properly connect-
ed to your PC.

The test gtring is transmitted to the Destination Unit and
looped back to the Source Unit. The RX Pane shows the test
string as received by the transceiver connected to the computer
after being loopbacked from the remote transceiver. If no data
is received within the timeout period the message “ Timeout” is
printed in the RX Pane. The TX Pane shows the test string as
typed in the dialogue box.

To perform acommunication link test it will be necessary to
use two Carrier wirel esstransceivers, two antennas, aloopback
connector and acomputer.

Perform the following tests:

*  Terminal mode
» Loopback test (Stand-alone model only)

TERMINAL MODE TEST — The Termina Mode tab pro-
vides a simple terminal interface from which data can be sent
between two units configured as a Broadcast Remote-to-All
Host and Remote Pair. Anything typed in the input field of
transceiver no. 1 will immediately be transferred to transceiver
no. 2. The datais displayed in the transmit pane for transceiver
no. 1 and the receive pane for transceiver no. 2. (NOTE: You
will only see received data if the destination transceiver is con-
nected to a PC with Configuration loaded and open or if the
destination PC’stransceiver has aloopback connector.)

What You Need:

e Two transceivers (A and B) configured as a host to
remote. The Source Unit ID of unit A equals the Desti-
nation Unit ID of unit B and vice-versa. In addition, both
units must have matching Vendor 1D numbers, Network
ID numbers and Hop Table numbers.

* One of these unitsis connected to a PC with the Config-
uration Manager loaded.



Test Communications Between Units:
1. Open the Configuration Manager. See Fig. 17.
2. Click the Terminal Modetab.
3. InTest String, enter some text.
4. Click Resend.
Thetest string is transmitted to the Destination Unit.

LOOPBACK TEST — The Loopback Test screen dlows
you to perform two functions; to test that two units can com-
municate and to determine the best placement of one unit rela-
tive to another based on received signal strength. This test is
only used for stand-alone models.

What You Need:

» Two transceivers (A and B): configured as a Broadcast
Remote-to-All and Host Pair. The Source Unit ID of unit
A equals the Destination Unit ID of unit B and vice-
versa. In addition, both units must have matching Ven-
dor ID numbers, Network ID numbers and Hop Table
numbers. Transceiver A is connected to a PC loaded
with the Configuration Manager.

NOTE: Test also workswith host/remote set up.

* Loopback connector: Transceiver B (the one not con-
nected to the PC running this program) must have a
loopback connector (pins 2 and 3 of the serial port tied
together) on the serial port of the remote unit. A loop-
back connector is delivered with all demo and devel oper
kits.

NOTE: Connect loopback connector to remote unitsif using a

host to remote set up.

Test Communications Between Units:

1. Open the Configuration Program. SeeFig. 18.
2. Click the Loopback Test tab.

3. InTest String, enter some text.

4. Enter the desired criteriain other fieldsin this group. The
default values are recommended for this type of testing.
The minimum for Repeat Every field is 100 msec.

5. Click Start.
Test the Placement of a Unit:
1. Click the Loopback Test tab. See Fig. 19.
Click Test.
Click Ingtantaneous RSSI.
Enter sometext in the Test String.

Enter the desired criteriain other fieldsin this group. The
default values are recommended for thistype of testing.

6. Click Start.

VIEWING DATA IN THE RX AND TX PANES — These
display areas show the data being transmitted and received dur-
ing tests. The RX pane shows data being received into the
transceiver. The TX pane shows data being transmitted from
the transceiver. All data sent will be displayed and at times the
pane may become cluttered. You can use the Clear buttons on
the toolbar or the commands in the Edit menu to clear the
panes of data. To clear datain the panes, select Clear RX Pane
or Clear TX Pane.

If the RX pane displays Timeout? each time the Test String
is sent then perform the following tests:

« Vertify that both antennas are properly installed on the
transceivers.

* Reposition the transceivers such that the green signa
strength bar is as long as possible. Normally signal
strengths above .5 are required for reliable communica-
tions (see Antenna Selection and Location section).

e Attempt to utilize directional antennas in order to
obtain reliable communications (see Antenna Selection
and L ocation).
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Fig. 17 — Configuration Manager, Test Mode
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TROUBLESHOOTING (See Table 7)
Table 7 — Troubleshooting

PROBLEM

POSSIBLE CAUSE

POSSIBLE SOLUTION

“Timeout?” messages are displayed in the
Configuration Manager general tab fields.

The equipment is not connected properly.

Check that all connections are secure.
Make sure transceiver has power (LED 1 is lit).

Wrong serial port is selected.

Select the correct serial port in the serial tab of
the Configuration Manager

Antenna cannot be threaded onto the antenna

connector. handed” threads.

Antenna and antenna connector have “left-

Turn antenna connector counterclockwise to
attach to transceiver.

LED 1 not lit

Power is not being supplied to unit.

Check power supply connection into unit and
outlet. Make sure supply of power is active.

LED 1 and LED 2 flash 3 times Normal operation.

No need to troubleshoot.

Open the Configuration Manager and get an Outdated DLL.

error message

Run 401COMUPD.exe included in program
disk to install COMCTL32.DLL in your
C:\Windows\System directory.

System Configuration — Refer to the following to

check system configuration:

» Do the power and link LEDs blink 3 times as described
in the Setup section?

» Doesthe power indicator remain on after power up?

* Are the RS232 9-pin cables or R$485 converters
attached?

» If the RS232 9-pin cable is being used, do al 9 wiresin
the serial cable have continuity from one end to the
other?

» Areall connections secure to unit and connected device?

» Doesthe TX LED blink when you are sending data to
the transceiver from the computer or originating device?

» Doesthe unit communicate with aloopback test?

» If the transceiver is a Broadcast/Remote or Point-to-

Point, are the sync and power LED's on?

How far apart are the transceivers?

Arethey out of range?

What antennas are you using?

Where are they mounted?

If there is a cable run between the transceiver and the

antenna, how long?

» Have you tried to communicate with the transceiver in
different locations or with different antennas?

* What are the RF barriers between the antennas? See
Table 8.

Table 8 — RF Signal Barriers

BARRIER SEVERITY
Concrete Wall High
Metal Wall High
Wood Framed Wall Moderate
Glass Low
Trees Low to High depending on type

(high = Pine)
People High
(mount antenna above pedestrian traffic)

Vehicular Traffic High

Frequently Asked Questions (FAQs)
Q: Can | use an external antenna?

A: Yes, many different versions of 2.4 GHz omni-directional
or directional antennas can be used. Please contact Carrier for
additional information.

Q: Can | use other, longer runs of coax than what is provided
from Carrier?

A: Yes. Longer coax can be used but one should keep the
length of the coax as short as possible and use low loss coax as
appropriate for the length of the run.

Q: What types of coax can | use?
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A: RG-316, RG-223, LMR240, 300, 400, 600 and many other
typesthat are suitable for 2.4 GHz RF signals. It isimportant to
choose alow loss coax and redize that the longer the coax the
greater the loss. Also, remember that the Carrier transceivers
have a reverse thread SMA female connectors only so your
coax will need to mate with that.

Q: How great alength of coax can | use?

A: It depends on type of coax. A very low loss coax can be
used at distances up to roughly 50 ft. It iscritical, however, that
the correct coax and connectors are used and that the coax sys-
tem loss is not too great. The maximum power out of a Stand-
Alone Carrier Transceiver at the reverse threed SMA connec-
tor is 500 mW.

Q: When should | use a directional antenna versus an omni-
directiona antenna?

A: A directiona antennais a good choice any time you have
only a gpecific direction from which sgnas are sent or
received. If you have a Hogt (master) Carrier transceiver and
there are Remote Carrier transceiversin all directions from the
Host you should use a directional antenna in most if not all
cases. A directional antenna can extend your range by concen-
trating the radiated energy from the antennain a certain direc-
tion. Also, a directional antenna will only receive signals that
are in its specific angle reception. RF interference outside the
antennas area will not be ‘visble' by the antenna and in this
waly can increase the transceivers receive capability.

Q: The range specification with omni-directional antennas is
2 miles. Doesthat require line-of-sight?

A: Yes it does. If the range between antennas is short, say
1000 ft and there are no mgjor obstructions such as earth,
major metallic structures or other obstructions, chances are
good that an acceptable RSSI (receive signal strength indica:
tion) will be achievable at each transceiver. The problem is,
every applications environment is different and there is no way
to know for sure unless one tests the unitsin that actua physi-
cal setting.

Q: How much doesline-of -sight matter with Carrier transceivers?

A: Asagenerd rule, line-of-sight is required to assure commu-
nications. The Carrier transcelvers operate a 2.4 to 2.4835
GHz with a maximum power output of 500 mW. The trans-
ceiver's ability to receive adequate signd levels is entirely
dependent on the placement of the antennas and the distance
they are from one another. There is no absolute guarantee in
advance that a given ingallation of Carrier transceivers will
yield a good communication link. However, if the range is
under 1000 ft, adequate communication can be accomplished
in many cases without line-of-sight aslong as the proper anten-
nas have been selected and installed as required. In generdl,
with ranges up to and exceeding 1500 ft, line-of-sight is
required.



Q: Should | incorporate lightning surge protection for my
transceiver?

A: It is a good idea whenever your coaxid cable lengths are
20 feet or more. Contact your Carrier representetive.

Q: What is the highest baud rate of the Carier RS485
adapter?

A: 9600 Baud.

Q: How many network IDS are available?

A: 64,000

Q: How can | improve communications indoors?

A: Try using directiona antennasto lessen or eliminate bounc-
ing signals being received from the remotes.
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Q: Is it posshle for CCN communication retries to happen
because of wirelessinterference?

A: Yes, dthough Carrier wirdess modems are designed to
avoid communication interruption, it is possible for the user to
see duplicate alarms on a ComfortWORKS® or Comfort-
VIEW™ display dueto wirdessinterference.

Q: Are there limits to the application of wireless CCN
communications?

A: Yes. As with any wireless communicetion, the transceiver
can be interfered with by a physical blockage or electrical
interference. Carrier wireless transceivers should NOT be
ingtdled in applications where temporary loss of communica
tions cannot be tolerated by the control system. Suitable appli-
cations include equipment monitoring, adarm monitoring,
control overrides and temporary service connections.
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